Full Circle

LE MAGAZINE INDEPENDANT DE LA COMMUNAUTE UBUNTU LINUX
EDITION SPECIALE SERIE LIBREOFFICE

el

LibreOffice 3

The Document Foundation

ﬁ Spreadsheet ﬁ Database
Presentation E Formula

Ej‘ Open... |‘r i% Templates...

HBREQEEEE

Voluma Un  [Rarkias 1l & 7

Full Circle Magazine n'est affilié en aucune maniere a Canonical Ltd.



Au sujet du Full Circle

Le Full Circle est un magazine gratuit,:
libre et indépendant, consacré a toutes:
les versions d'Ubuntu, qui fait partie:
des systémes d'exploitation Linux. Chaque:
mois, nous publions des tutoriels, que:
nous espérons utiles, et des articles pro-:
posés par des lecteurs. Le Podcast, un:
complément du Full Circle, parle du:
magazine méme, mais aussi de tout ce:
qui peut vous intéresser dans ce domaine. :
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Cette édition spéciale vous est:
fournie sans aucune garantie ; les:
auteurs et le magazine Full Circle:
declinent toute responsabilité pour:
des pertes ou dommages éventuels:
si des lecteurs choisissent d'en appli-:
quer le contenu a leurs ordinateur et :

matériel ou a ceux des autres.
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TUTORIEL

Ecrit par Elmer Perry

[ Y LibreOffice

The Document Foundation

ans ce tukoriel, je vais vous

présenter la suite bureau-

tique LibreOffice et en

décrire chacun de ses
modules. Au fur et & mesure que la
série avance, je compte traiter chaque
module beaucoup plus en dékails, ainsi
gue les moyens de partager des infor-
mations entre ceux-ci.

LibreQOffice a de Fortes chances
d'étre la suite bureautique par défaut
dans Ubuntu 11.04 et elle comprend
plusieurs modules qui vous permet-
tent de creer des documents texte, des
tableurs, des présentations et des des-
sins. Multi-plateforme, cette suite est
disponible pour Linux, Windows et Mac
5. Elle vous donne la possibilité de sau-
vegarder et de lire des documents
dans le Format par défaut Open Docu-
ment Format (ODF), ainsi que dans plu-
sieurs versions de Microsoft OFfice,
Rich Texk Format (RTF) et DocBook. Cet-
te Fonctionnalité seule Fait d'elle une
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5i vous ne voulez pas attendre le mois d'avril

pour essayer LibreOffice sous Ubuntu, vous pouvez l'installer a partir
des PPA [Personal package archives]. Saisissez les trois commandes
suivantes dans le terminal (Applications > Accessoires = Terminal) :

sudo add-apt-repository ppa:librecffice/ppa
sudo apt-get update

sudo apt—get imstall librecffice

nateur, j'ai été obligé de désinstaller OpenOffice avant que LibreQf-
fice veuille bien s'installer a partir du PPA. Je ne sais pas si ce
probléme technigue était lié @ ma machine ou s'il est impossible que
les deux soient présents en méme temps et en utilisant les PPA, Si
vous voulez vous servir a la fois d'OpenOffice et de LibreOffice, la
meilleure chose a faire est de les installer & la main en les téléchar-

B Export..

Properties...

Digital Signatures...
Templates

Preview in Web Browser
Page Preview
Print... Ctri+P

Printer Settings...

Exit Ctri+Q

o

geant sur leur site respectif : openoffice.org et libreoffice.org.

[Mote du rédacteur en chef : quand j'ai installé LibreOffice & partir des
PPA ci-dessus, mon OpenOffice a été gutomatiguement désinstallé.]

Une de ses Fonctionnalités les plus
puissantes et les plus utiles est sa capa-
cité de créer un Fichier PDF a partir du
document courant. Exporter vers PDF
vous donne un plus grand contréle sur
le document final Le destinataire peut
fFacilement modifier un fichier dans le
Format ODF ou Microsoft Office. Cepen-
dant, le format PDF rend ['altération du
document plus difficle. Vous trouverez

spécial libreoffice @) volumeun 3
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La derniére commande peut prendre pas mal de temps. Sur mon ordi- !
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|

la fonction Exporter ou Exporter vers
PDF dans la plupart des modules a Fi-
chier > Exporter... ou Exporter vers
PDF...

Démarrer LibreOffice 4 partir du
menu Applications : Applications > Bu-
reautique > LibreQFffice, 5i aucun docu-
ment n'est ouvert, LibreOffice affiche
l'écran d'accueil qui vous permet d'ac-
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céder rapidement aux divers modules
de la suite.
.

LibreOffice 3
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« Document texte » lance le modu-
le Writer, qui a toutes les Fonctionna-
lités habituelles d'un traitement de
texte. Dans Writer, vous pouvez bouk
écrire, de la simple lettre au roman.
Avec le traitement de texte de Writer,
vous pouvez mettre en page des arti-
cles académiques, des documents tech-
niques et la decumentation pour un
produit ou un logiciel. Parfois, Writer
r'arrive pas bouk a Fait 3 traduire des mi-
ses en page complexes du Format
Word de Microsoft, mais, en régle
générale, vous n'aurez pas beaucoup
de problémes.

« Classeur » lance Calc. Calc est com-
patible avec Microsoft Excel. Calc vous
permet de créer un tableur avec des
calculs et des Formules automatiques,

Vous pouvez vous servir de Calc aussi
pour des collectes de données a impor-
ter dans d'autres documents. Avec
Calc, vous pouvez ajouter des graphi-
ques et des courbes pour afficher vos
données et vos calouls de Fagon parlan-
te. Les tableaux, les graphiques et les
courbes de Cale peuvent simporter
Facilement dans d'autres documents Li-
breOffice. Calc vous permet davoir
plus d'un tableur dans un document ;
ainsi, vous avez la possibilité d'insérer
des tableurs mensuels, annuels ou au-
tre, dans un seul et méme document.

# Présenkation » lance Impress. Im-
press est la version LibreOffice de Po-
werPoint de Microsoft et le remplace
avantageusement, Impress propose
toutes les Fonctionnalités que wvous
voudriez trouver dans un programme
de présentation : les transibons entre
les diapositives, lincorporation dob-
jets, le son, des effets de texte, des
graphiques, etc. J'ai déja utilisé Impress
dans mes cours et dans des séminaires
et Impress me rend toujours les servi-
ces gqu'il Faut.

« Dessin » démarre le module Draw.
Dans Draw, vous pouvez créer des des-
sins vectoriels simples afin de les utili-
ser dans d'autres documents. Il vous
serait facile de faire un organigramme
ou un logo dans Draw,

spécial libreoffice @) volume un

« Base de données » ouvre le mo-
dule Base. Utilisez Base pour créer une
base de données qui peut se servir de
plusieurs moteurs différents selon ce
qui est installé sur votre systéme. Base
est utile pour limportation de données
dans d'autres documents de la suite. Si
vous avez besoin d'une base de don-
nées pour inventaire ou ventes, vous
pourriez vouloir essayer Base.

« Farmule » lance le module Math.
Avez-vous jamais eu besoin dincorpo-
rer une formule mathématique comple-
=2 dans un document ? Formule est la
solution, La puissance de Formule vous
donne la possibilité de créer des Formu-
les bien Formatées afin de les utiliser
dans d'autres documents. Formule est
vraiment ce qu'il vous Faut quand vaous
créez des documents scientifiques ou
techniques et avez besoin dinsérer
une formule ou un algorithme avec vo-
tre bextbe,

Address
Company
FirstfLast name/Initials e
Street
City/State/Zip
CountryfRegion
Title/Position
Tel (Hemea/ork)

Fax  E-mail

A
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Avant de démarrer avec LibreOFFi-
ce, regardons quelgues-unes des
options qui sont associées a tous les
modules. Quvrez Qutils = Options > Li-
breOffice > Données didentité. Cest
ici gque vous saisissez les données per-
sonnelles que vous voulez rendre dis-
ponibles au programme. Vous pouvez
transférer certaines des informations
fournies vers des documents. Quel-
gues-unes des proprietés des docu-
ments viennent de données dans ces
charmps, notamment le nom de lau-

teur du document provient des
F Ty
Help

B Tips

B Help Agent

Openfsave dialogs
Use LibreQffice dialogs

Document stabus
& Printing sets "document modified" stat

Allow to save document even when the

Year (bwao digits)

Interpret as years bebween

Y -
champs Prénom/Mom. Le logiciel se
sert aussi des champs Prénom/Mom
pour les réviseurs.

Ensuite, si vous ne connaissez pas
encore LibreOffice, allez dans Qutils =
Options = LibreQffice > Général et co-
chez « Infobulles » et « Assistant ». Pen-
dant que vous apprenez a bien vous
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servir de LibreOffice, il se peut que
vous vouliez activer les « Infoballons ».
Les Infoballons afficheront une infobul-
le détaillée pour chaque chose lorsque
vous passez la souris dessus. Sans ceux-
d, vous n'avez qu'une description suc-
cincte des boutons de la barre des ou-
tls. Lorsgue l'« Assistant » est active,
une boite d'aide s'affichera de temps
en temps dans le coin en bas & droite
de la fenétre. En cliquant dessus, vous
aurez tout de suite la page de documen-
tation concernant votre tache actuelle.
Ceci vous aide a apprendre LibreQffice
nettement plus rapidement. L« Assis-
tant » est comme l'assistant d'Office
de Microsoft.

Office afin de le Faire automatique-
ment, au liew davoir a toujours
sélectionner le Fformat requis, Choisis-
sez le type de document dans le menu
déroulant « Type de document ». Choi-

Default - English (LSA)

Default - English (USA)
B Same as locale setting (. )
Default - USD

=]
B Loed iser-speaific sekbings with the dooumeal

& Lo pringer seifings mith Ehe desument

RrEE
B [t document propeste befome nading

Algays creake hackup copy
B Lo Al Deftecsniony IFBETADan Sy b5 |3
W Seree LALS refative bo File sysbem
B Soree LRLS redative Do ibernet

sfaul e format and ODF Leitiegs

SGF Pormet verdian 1.3 Exberetbe [ i)

B ize optimizatesn far GOF
[T ayalrg in GOF or defauk formet

AT e o

OLF Teak Dosoument
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Et maintenant, nous allons voir Ou-
tils = Options > Chargement/Enregistre-
ment > Général. Cest ici que wvous
pouvez paramétrer le Format par dé-
Faut pour les différentes sortes de docu-
ment. Si vous aver toujours besoin de
sauvegarder sous un des formats de Mi-
crosoft, vous pouvez configurer Libre-

% Default - English (Usa)
Default - Chinese (simplified)
Cefault - Hindi

Eor the current document only

. J
’Writing aids i
fvailable language modules
= Hunspell speliChecker

Uzer-defined dictionaries

7 standard [All

& oracle [all]

& technical [all]

= soffice [all]

B 1gnoreallList [all]

Cphions

Minimal number of charackters F
Characters befare line break: 2
Characters after line break: 2
Hyphenate without ingquiry

i

Hyphenate special regions

Si vous avez toujours
besoin de sauvegarder
sous un des formats
de Microsoft, vous
pouvez configurer
LibreOffice afin de le
faire automatiquement

sissez le Format par défaut pour ce ty-
pe de document dans le menu dé-
roulant « Enregistrer systématigue-
ment sous »,

Dans Outils > Options > Paramé-
tres linguistiques > Langues, vous confi-
gurez les options de langue. Sous les pa-
ramétres de langue, vous avez la
possibilité de cocher « Uniguement
pour le document actif ». Dans Pa-
rameétres linguistiques > Linguistique,
vous pouvez configurer les options
pour les dictionnaires, la vérification
d'orthographe et les césures,

Libre & vous de parcourir les autres
options. Mous allons traiter les options
pour chaque module en méme temps
que le module. La prochaine Fois, nous
commencerons avec l'utilisation de
base du module Writer.

spécial libreoffice @) volumeun 5

Tauk eat possible 4 vais
awez une tablette,
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Ecrit par Elmer Perry

ans mon dernier article, je :
vous ai présenté les dif-:
férents modules du pro-:
gramme LibreOffice. Aujour-:
d'hui, je voudrais vous montrer les :
méthodes de configuration de base :
et du formatage manuel pour le mo-:
dule Writer. Le module Writer vous :
permet de créer des documents texte :
Formatés. Vous pouvez vous servir de :
Writer (ci-dessous) pour quelque chose :
d'aussi simple qu'une lettre ou un jour- :
nal ou d'aussi complexe qu'un manus- :

crit ou une these.

Nous regarderons d'abord la fené- :
tre de Writer. Tout en haut, ily a la:
barre des menus qui vous permet d'ac- :Z _
céder a tous les outils du module et a :
toutes les actions possibles sur un:
document. En dessous de la barre des :
menus, il y a la barre d'outils stan-:
dard. Celle-ci vous donne un accés ra- :
pide aux commandes usuelles comme :
Ouvrir, Enregistrer et Impression rapide. :
A c6té de la barre d'outils standard se :

Untitled 1 - LibreOffice Writer

File Edit View Insert Format

|5 S @ -l

Table Tools window Help

trouve une fenétre « Rechercher »,:
une barre de recherche. Sous la barre :
d'outils standard, il y a la barre d'ou-:
tils de formatage - ou vous trouverez :
des icbnes correspondant a des outils :
habituels de formatage. Cette barre :
d'outils est contextuelle et changera:
quand vous travaillerez avec des élé-:
ments tels que le dessin d'objets. Si:
vous avez activé les infobulles, une:
description de ce que fait chaque icone :
s'affichera lorsque vous passerez la:

souris dessus.

Centimeter

Point
Pica

‘l@E-FIE2dSEm 1 Q8 [Ad

v | | Times New Roman

I Default \ B 12\ B

AAA\\I%~@’-E/\|

A o e D S S |

el e = 8 At A |

\

I

N

Rulers

Standard Toolbar

Search Toolbar

Formatting Toolbar

LN I

l'une horizontale et l'autre verticale. :
Les régles sont des guides pour vous :
aider a faire la mise en page d'un:
document. Par défaut, pour l'anglais, :
les regles s'affichent en pouces. Ily a':
deux facons de modifier les unités de :
mesure des régles. Faites un clic-droit :
n'importe ou sur une régle (3 gauche) :
et Writer affichera un menu des diffé- :
rentes unités. Cette méthode fonc-:
tionne mieux quand vous n'avez besoin :
de la modification que pour le docu-:
: ment en cours. Si, toutefois, vous avez
. besoin d'une autre unité de mesure :

Sous la barre d'outils de Forma-§ par défaut, vous devrez la changer:

tage, a gauche, vous avez des régles,; dans les options. Allez a Outils >:
: Options > LibreOffice Writer > Affi-: - =2
. chage. Clest ici que vous pourrez: la date. Sélectionnez celle que vous
Millimeter - : paramétrer les unités par défaut des:
. régles (verticale et horizontale) ou:

: choisir de travailler sans les régles.

: Bien, nous allons maintenant créer : [
© une lettre simple et je vous montrerai :
: comment formater manuellement les :
- différents paragraphes de celleci. Lan-:
: cez LibreOffice et démarrez un nou-:
: veau Document texte. Nous mettrons :
. la date actuelle en haut du document: | T s
_: et l'alignerons a droite. Allez a Inser- : droite, alors trouvez le's lcones dali-
tion > Champs > Date. Cedi affichera gnement sur la barre d'outils du for-
: la date dans le format par défaut:
© (ji/mm/aa). Vous remarquerez que la:
: date est surlignée en gris, ce qui vous :

spécial libreoffice @) volumeun 6

_ Fri. December 31, 1999 J

signale que c'est un champ que vous
avez inséré dans le document.

Changeons le formatage de la

Format
12/31/99 -
12/31/1999
Dec 31, 99
Dec 31, 1999
31. Dec. 1999 |
31. Dekl®mber 1999

Fri, Dec 31, 99
Fri 31/Dec 99

: date. Double-cliquez dessus et une
. fenétre de dialogue (ci-dessus) s'affi-

chera avec les diverses options pour

voulez et cliquez OK.

I

- J

Il Faut maintenant aligner la date a

matage et cliquez sur celle qui cor-
respond a « Aligner a droite ». La date
se mettra contre la marge de droite.
Utilisez la touche Fin de votre clavier
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f ﬁ Defaulk
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bourlaller jusqu'au bout de la ligne
actuelle et appuyez sur Entrée. Nous
ne voulons pas que le texte du nou-
veau paragraphe soit aligné a droite,
il faut donc cliquer sur l'icone « Ali-
gner a gauche » pour que le début du
paragraphe soit contre la marge de
gauche. Saisissez votre formule de
politesse et appuyez sur Entrée.

alinéa de chaque premiere ligne.
Quand la précision ne vous tracasse
pas, vous pouvez faire cet alinéa en
vous servant de la regle horizontale.
Vous y remarquerez deux triangles
sur la marge de gauche (ci-dessus a
gauche et a droite), l'un dont la
pointe va vers le haut, et ['autre dont
la pointe va vers le bas. Le triangle du
bas - celui dont la pointe va vers le
haut - vous permet d'ajuster 'alinéa a

- gauche pour tout le)paragraphe. Vous
‘en remarquerez un tout & fait sem-
‘blable a droite, qui sert a ajuster
:'alinéa a droite pour le paragraphe.
:Le triangle du haut a gauche - celui
:dont la pointe est dirigé vers le bas - :
: ajuste l'alinéa de la premiére ligne du :
- paragraphe. Cliquez sur le triangle du :
-haut et déplacez-le d'environ 1,27 cm :

Pour les paragraphes du corps de 5(0'5 ) :
notre lettre, nous voulons faire un : Si vous avez besoin d'alinéas plus :

: précis, vous pouvez atteindre la boite :

- miere ligne en 1,27 cm (0,5"). Cliqueé
: OK. Vous remarquerez que le triangle
- du haut (l'alinéa de la premiére ligne,
-voir ci-dessous) a bougé jusqu'a la
- position indiquée par vos soins dans

: e
: [ | 3 7. Y R S W S
consequadl, magnd nNunc po:

Vous pouvez maintenant taper votre

. paragraphe. Tapez-le et appuyez sur
- Entrée. Vous remarquerez que l'alinéa
:de la premiére ligne du paragraphe
- suivant est exactement pareil a celui
- du paragraphe précédent. Writer utili-
: sera ce style de paragraphe jusqu'a ce
- qu'on lui dise de faire autre chose.

=

.
Indents & Spacing | Alignment Text Flow Outline & Numbering Tabs Drop Caps Borders

Indent

Before text
After text

First line

Automatic

b

0.00"

4

0.00"| =

0.50" =

J

Y

2 tincidunt, Nulla urna arcu, ¢

\
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Une fois le corps de notre lettre

_tapé, nous aurons besoin d'ajouter
-une signature, mais nous ne voulons
- pas que notre signature soit pareille
:aux paragraphes du corps. Avec soit
: la méthode de déplacement, soit celle
- de la boite de dialogue style du para-
- graphe, mettez l'alinéa a 7,62 cm (3").
- Maintenant, tapez votre formule de
- politesse et appuyez sur Entrée. Au
‘lieu de taper votre nom, utilisons le
champ Auteur pour insérer votre nom :
:Insertion > Champs > Auteur. Cela ne
sodales, sem neque fermel - fonctionnera que si vous avez rempli

: les données d'identité dans les options.

volutpat mollis tempus, 89 Votre lettre est maintenant terminée,

M B W M - et vous pouvez 'imprimer et ['envoyer.
bibendum, elit eget condiy

. \ .
-de dialogue concernant le style du ;ledlalogue.

: paragraphe (ci-dessous a gauche) en
- double-cliquant sur la partie grise de
la régle horizontale. Vous l'atteindrez
- également en allant a Format > Para-
-graphe. Ici, vous trouverez beaucoup
:d'options de formatage du para-
: graphe. Aujourd'hui, ce qui nous inté-
‘resse c'est seulement l'alinéa de la
.premiére ligne, alors changez Pre- : .
: ' :La prochaine fois, je montrerai com-

imet mauris. Proin sollicitudi
it condimentum sodales in sit|
am elit neque. accumsan ey i

Le formatage manuel fonctionne

- bien pour des petits documents, mais
- de plus grands documents nécessitent
- davantage de contréle. Si vous déci-
: diez de changer le formatage de quel-
- ques paragraphes dans un plus grand
- document, le faire paragraphe par para-
: graphe deviendrait vite lassant. Dans
-un plus grand document nous aurons
:besoin de pouvoir changer tous les
: paragraphes similaires en une seule fois.

ment utiliser « Styles et formatage »
pour ce faire.

]

LibreOffice

The Document Foundation
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a demiére fois, le sujet était la :
modification de la mise en page
des paragraphes pour formater :
votre document. Tandis que':
cette méthode est bonne pour de courts :
documents, elle crée beaucoup de travail :
si vous décidez de changer quelque :
chose dans un document plus long. Et
c'est la que ['utilisation de styles rendra:
les choses plus faciles.

Writer de LibreOffice posséde cinq
types de styles différents : paragraphe, :
caractére, cadre, page et liste. Vous ac-:
cédez a tous les styles en cliquant sur le :
bouton Styles et Formatage dans la barre :

d'outils de formatage. La fenétre des : |

styles et formatage apparaitra. Vous
pouvez alors ancrer la fenétre sur la:
gauche de la barre d'outils de formatage :
en appuyant sur la touche Ctrl tout en:
double-cliquant sur l'espace vide dans la :
barre d'outils de la fenétre des Styles et :
Formatage. :

Sur la barre d'outils de styles (ci-:
dessus a droite), il y a septicones. Les cinq :
premiéres vous donnent acces aux dif- :
férents types de styles. Dans l'ordre, a:
partir de la gauche, ils sont paragraphe, :
caractere, cadre, page et liste. Dans cet :
article, nous allons parler surtout des

ghitle List Styles

.| Paragraph styles

: Etyles paragraphe et caractere.

| ™ Styles and Formatting |

: et Formatage, faites un clic droit sur:
© «Titre principal » et choisissez Modifier... :
© La boite de dialogue qui s'affichera alors :
© ressemble beaucoup a celle du dernier :
© article, maiis il y a quelques onglets nou-:
© veaux qui ne figurent pas dans la boite de :
: dialogue « paragraphe » standard. Le pre- :
© mier s'intitule Gérer. L'onglet Gérer (ci-:
: dessous) affiche le nom du style, le « Style :
© de suite » et « Lié 3 », le style auquel il est :
: lié. Vous verrez que le Style de suite est :
© actuellement « Sousitre », mais, puisque
© nous ne voulons pas utiliser un soustitre,
© on changera pour le style « Corps de':
© texte ». Ainsi, quand on appuiera sur En-
© trée pour démarrer un nouveau para-:
© graphe, celui-di utilisera le style « Corps de :
© texte ». Le style « Titre principal » est lié au
© style « Titre » . Quand des styles sont liés, :
© toute modification au style parent aura§

ip) ipl
ubtjtle

Page Styles

Frame Styles
Character Styles

Category drop-down box

|Chapter Styles

Ouvrez un nouveau document texte :
© et tapez un titre. Ouvrez la fenétre Styles
: et Formatage. L'icdne paragraphe devrait :
© étre sélectionnée par défaut. Enbasde a :
: fenétre Styles et Formatage, il y a une':
 liste déroulante. Sélectionnez Styles de:
: chapitre. Double-cliquez sur « Titre prindi- :
: pal ». Votre titre sera maintenant centré, :
© en gras, et deviendra plus grand. Nous al- :

lons maintenant modifier le style par dé-

faut pour les titres. Dans la fenétre Styles

un effet sur les styles qui y sont liés. Par
exemple, si vous mettez le texte dans le
«Titre » en bley, le texte de tous les styles
quiy sont liés deviendra bleu également.

Nous allons maintenant changer le
format de notre titre. Cliquez sur l'onglet
Effets de caractére. Les Effets de carac-
tére (en haut a gauche de la page
suivante) vous permettent de modifier
l'apparence de la police, couleur, barré,
soulignage, ombre et relief. La boite de
dialogue vous montre lapparence du
texte de votre titre lorsque vous y appli-
quez des effets. Changez-en la couleur a
bley, le soulignage a Ondulation double
et la couleur du soulignage a bleu. Cliquez
sur OK.

Appuyez sur Entrée pour démarrer
un nouveau paragraphe. Vous remarque-

~

Outline & Numbering Tabs Drop Caps Background Borders
Organizer @ Indents & Spacing | Alignment = TextFlow Font FontEffects | Position
Name Subtitle ] AutocUpdate
MNext Style \Text body =9
Linked with Heading )
Category Chapter Styles
Contains

Western text: 14pt + Italic + Centered

\§
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Outline & Numbering Tabs Drop Caps Background Borders
Organizer = Indents & Spacing =~ Alignment = Text Flow @ Font | Font Effects | Position
Font color Overlining oOverline colo
- 5 (without) 2 [] Automatic
Effects Strikethrough
(Without) = (Without) -
Relief Underlining Underline color
(without) - Double Wave | Il Blue =
Outline Individual words
Shadow
Blinking
Hidden
Times New Roman
| OK Cancel _ﬂelp Reset §tandard

?ez que le style est devenu « Corps de:
texte », exactement tel que nous l'avons :
configuré dans longlet Gérer. Tapez :
maintenant trois paragraphes de texte :
que vous utiliserez comme document :

d'exemple.

lignes et la premiere ligne a 0,50. Vous

été appliquées aux trois paragraphes.

paragraphe pour les longues citations.

. Mettez votre pointeur n'importe ou dans
. le deuxiéme paragraphe. Dans la fenétre

Ensuite, nous modifierons le style :
« Corps de texte » et en créerons deux :
nouveaux basés sur celuici. De retour :
dans la fenétre Styles et Formatage, cli- :
quez sur la liste déroulante et sélection- :
nez la catégorie Styles de texte. Faites un :
clic droit sur « Corps de texte », puis sélec- :
tionnez Modifier. Dans ['onglet Retraits et :
Espacement, changez linterligne a 1,5 :

Styles, faites un clic droit sur Corps de
texte et choisissez Nouveau. Dans l'on-
glet Gérer, appelez-le « Citation longue ».
Changez Style de suite a « Corps de
texte », puisqu'on n'a pas souvent deux
longues citations a la file. Vous remar-
querez que, puisque nous avons créé le
nouveau style en faisant un clic droit sur
Corps de texte, il est lié a « Corps de
texte » automatiquement. Si vous voulez

spécial libreoffice

e

créer un nouveau style qui ne soit pas lié a

un autre, changez le lien a « Aucun(e) ».

lons que le premier paragraphe de

- chaque chapitre ait cette apparence,
. nous allons créer un autre style. A nou-
: Maintenant, changeons le formatage :
: de notre nouveau style. Dans 'onglet Re-
. traits et Espacement, changez le « Avant
. le texte » et « Aprés le texte » & 0,50.
. Changez le retrait de a « Premiére ligne » :
: pour qu'il soit & nouveau a 0,00. Dans l'on-
. glet Police, changez le style 2 Italique. Cli-
. quez sur OK et vous verrez qu'un:
' nouveau paragraphe appelé « Citation :
- longue » a été ajouté a votre liste. A nou- :
: veau, mettez le pointeur n'importe ou:
: dans le deuxiéme paragraphe et double-
- cliquez sur « Citation longue ». Vous ver- :
: rez alors que le retrait de la premiere
. ligne n'existe plus, que le paragraphe a un

— ) alinéa des deux cotés et que le texte est :
constaterez que ces modifications ont : o . :
. en italique. Nous voulons maintenant :
. changer le premier paragraphe pour qu'il :

, . . ait quelques lettrines. Puisque nous vou-
Nous allons maintenant créer un: qued .

veay, faites un clic droit sur « Corps de
texte » et choisissez Nouveau. Appelez le
nouveau style « Premier paragraphe » et
réglez le Style de suite a « Corps de
texte ». Dans l'onglet Retraits et Espace-
ment, mettez le retrait de la premiéere
ligne a nouveau a 0,00. Dans l'onglet Let-
trines (voir ci-dessous), cochez « Afficher
des lettrines », réglez le « Nombre de ca-
ractéres » 3 1 et la « Hauteur (en lignes) »
a 2. Cliquez sur OK. Comme auparavant,
aucune modification n'est encore visible.
Mettez votre pointeur dans le premier
paragraphe et double-cliquez sur votre
nouveau style.

Ce nouveau style de paragraphe de-
vra suivre le titre de chaque nouveau cha-
pitre. Modifiez le style du « Titre » pour

Organizer | Indents & Spacing
Outline & Numbering

Alignment
Tabs

Settings

Drop Caps

N
Fonkt Font Effects

Background

Position
Borders

Text Flow

[& Display drop caps
Wwhole word

Number of characters:

Lines 2 -

Space to text 0.00" =

A

Conktents

Text

Character Style

b=
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que le Style de suite devienne « Premier
paragraphe ».

ractere et double-cliquez

est possible de modifier les styles de ca-

. ractere de la méme facon que les styles .
- de paragraphe. :

Les styles de caractere ne sap- :
pliquent qu'au texte sélectionné et non :
pas a des paragraphes entiers. Sélection- :
nez une partie du texte du troisieme :
paragraphe. Dans la fenétre Styles et For- :
matage, cliquez sur licéne Styles de ca- :
sur -«
Accentuation ». Ainsi, le texte sélectionné :
passera en italique. En regle générale, il :

L'avantage principal des styles est :
que le formatage d'un méme type de :
texte reste identique tout au long du do- :
cument. Dans le prochain article, nous :
parlerons de l'‘ajout de cadres au docu- :

ment.

=

Elmer Perry, dont les passe-temps incluent
le web design, la programmation et ['écri-
ture, est pasteur pour les enfants a Ashe-
ville en Caroline du Nord

I

Paragraph Stvles Example

HE heard quiet steps behind him. That didn't bode well. Who could be following him this late at
night and in this deadbeat part of town? And at this particular moment, just after he pulled off
the big time and was making off with the greenbacks. Was there another crook who'd had the same
idea, and was now watching him and waiting for a chance to grab the fruit of his labor? Or did the steps
behind him mean that one of many law officers in town was on to him and just waiting to pounce and

snap those cuffs on his wrists? He nervously looked all around. Suddenly he saw the alley.

Like lightning he darted off to the left and disappeared between the two warehouses
almost falling over the trash can lying in the middle of the sidewalk. He tried to
nervously tap his way along in the inky darkness and suddenly stiffened: it was a dead-
end, he would have to go back the way he had come. The steps got louder and louder, he
saw the black outline of a figure coming around the corner. Is this the end of the line? he

thought pressing himself back against the wall trying to make himself invisible in the

special libreoffice &) volume un
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C'est dangereux
de demander
"Puisje vous aider ?"

La plupart des gens
réagissent
enracontant leur vie

by Richard Redei
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Ecrit par Elmer Perry
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ans le dernier article, nous§

avons utilisé les styles de:

paragraphe pour formater:

notre document en créant:
des styles réutilisables qui rendent le:
document homogeéne. Dans cet article-:
ci, nous allons créer une mise en page:
plus avancée en se servant de cadres.:
Alors qu'il existe d'autres programmes, :
tel Scribus, créés plus particuliere-:
ment pour faire de la mise en pages:
avancée, LibreOffice nous propose:
plusieurs outils qui nous permettent:
de produire des documents avec une:
mise en pages plus complexe que:

Vous pouvez imaginer les cadres:
comme des boites qui servent a contrd-:
ler le Flot du texte, des graphiques et:
d'autres éléments du document. Une:
des fonctions clés des cadres est leur:
capacité de se lier 'un a l'autre. Quand:
deux cadres sont liés, le texte dans:
('un coule automatiquement dans l'autre, :
méme si les deux cadres se trouvent:
sur des pages différentes. Cette fonc-:
tion rend les cadres idéaux pour les:
bulletins d'information et d'autres docu-:
ments a base d'articles. :

Nous allons créer la mise en pages:

Flux du texte de l'article. Commencez:
par créer un nouveau document. Main-:
tenant, dans les menus allez 3 Inser-:
tion > Cadre. Le dialogue Cadre s'affi-:
chera. Sous l'onglet « Type », cochez:
Relatif pour la largeur et pour la:
hauteur. Régler la largeur & 100 % et:
la hauteur 3 25 %. Dans la section:
Position, réglez I'horizontale & gauche:
3 0.00 cm pour Zone de paragraphe.:
Réglez la position verticale en haut a:
0.00 cm pour Marge. :

Sous |'onglet Options, nommez le
cadre « En-téte d'article ». Les cadres
sont nommés automatiquement sous
format « Cadre# », ou # est le nombre
de cadres dans le document. Il est
toutefois souhaitable de donner un
nom significatif a vos cadres pour que
vous puissiez vous souvenir de leur
fonction.

Par défaut, les cadres ont une
bordure sur les quatre cotés, mais
nous voulons une bordure unique-

celle d'une simple lettre. Un de CeSE du premier article (voir ci-dessous) en; Type |Options | Wrap | Hyperlink Borders Background Columns Macro
outils le plus utile est le cadre. . se servant de cadres pour controler le: | Anchor
s N width 100%]| = ) To page e
& Relative @® To paragraph
ThE -I-Itle Of Al‘tiﬂle [C] Automatic ) To character
by'Au!‘hnr Height 25% = ) As character
) o o ) ) & Relative
HE: heard quiet steps behind him. That didn't bode well. Who could be following )
him this late at night and in this deadbeat part of town? And at this particular moment, Autosize
Just after he pulled off the big time and was making off with the greenbacks. Was ] Keep ratio
there another crook who'ld had the same idea, and was now watching him and waiting i
for a chance to grab the fruit of his labor? Or did the steps behind him mean that one Position
of many law officers in town was on to him and just waiting to pounce and snap those : — — —
Horizontal  |From left :| by |0.00" | to |Paragrapharea |
cuffs on his wriss? He nervously looked all darted off to the left and disappeared between O Mi
around. Suddenly he saw the alley. Like the two warehouses almost falling over the trash RECOL R R B
lightning he darted off to the left and can lying in the middle of the sidewalk. He tried vertical ‘From top =] by [oor - to  |Margin -
disappeared between the two warehouses almost to nervously tap his way along in the inky —_— -
falling over the trash can lying in the middle of darkness and suddenly stiffened: it was a dead- ] Follow text Flow
the sidewalk. He tried to nervously tap his way end, he would have to go back the way he had
along in the inky darkness and suddenty come. The steps got louder and louder, he saw
L stiffened: it was a dead-end. he would have to the black outline of a figure coming around the [—%] | Cancel | | Help | | Bk
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4 )

Line arrangement
)efault

User-defined

-
'

ment en bas de notre cadre. Sous
l'onglet Bordures, sélectionnez le.
premier carré sous « Disposition des:
lignes » par défaut. Cela annulera:
toutes les bordures. Cliquez en bas de:
la boite « Défini par ['utilisateur »:
pour créer une bordure en bas de:
votre cadre.

Name Article Header]
Previous link <None>
Next link Article Body

a
*

a
*

nouveau, dans les menus, choisissez:

. Insertion > Cadre. Nous voulons a:

© nouveau une largeur et une hauteur:

Nous avons maintenant terminé:
avec le paramétrage de ce cadre-i.:
Nous y reviendrons lorsque nous:
serons préts a lier nos cadres. Pour le:
moment, cliquez sur OK. Vous verrez:
le nouveau cadre dans le document.

Nous allons maintenant créer un:

. cadre pour le bas de l'article. Cliquez:

. en dessous du cadre d'En-téte. A
. l'article ait deux colonnes. Cela se fait:

\Z

Settings

Columns

2| -

width and spacing

Column

width

Spacing

AN = S = P ==

e~ F—
47% 47%

6% =

& Autowidth

. d'article ». Sous l'onglet Bordures,: N
L ? ong . sur la bordure du cadre En-téte (le
cliquez sur « Ne définir aucune bor-: . »
© premier cadre que nous avons créé).

. Le dialogue Cadre s'affichera. Sous

« Relatif ». Réglez la largeur 3 100 %:
et la hauteur & 75 %. Réglez la posi-:
tion horizontale & gauche & 0,00 cm:
pour Zone de paragraphe. Sous l'on-:
glet Options, nommez le cadre « Corps§

dure ».

Nous voulons que le corps de?

. sous l'onglet Colonnes. Modifiez le:
. nombre de colonnes en 2 et réglez:
. l'espacement a 6 %. Cliquez sur OK et:
. le nouveau cadre s'affiche. Vous:
. aurez peut-étre besoin d'ajuster la:
. position des cadres pour qu'ils s'ali-:
. gnent correctement. Vous ajustez la:
. position des cadres en cliquant sur la:
. bordure des cadres. Vous verrez alors:
. des poignées vertes sur la bordure.:
. Celles-ci servent a ajuster la taille du:
. cadre. En principe, nous n'aurons pas:
. besoin d'en changer la taille - uni-:
. quement d'en ajuster la position.:
. Pour ajuster la position des cadres,:

cliquez et tirez sur la bordure la ou il

Special ibreoffice () volumeun 12

n'y a pas de poignées vertes. Pour des
ajustements plus précis de la position
du cadre, tilisez les touches
Alt+Fleches.

Les cadres sont maintenant (3 ou
nous les voulons. Avant de com-
mencer 3 écrire l'article, nous devons
lier les deux cadres. Double-cliquez

['onglet Options, cliquez sur la fléche
a coté de Lien suivant et choisissez
« Corps d'Article ». Les deux cadres
sont maintenant liés. Cliquez sur OK
pour accepter cette modification et
retournez au document.

Dans le document, cliquez a l'in-
térieur du cadre En-téte. Formatez un
titre et le nom du journaliste en uti-
lisant n'importe laquelle des méthodes
présentées dans les articles précé-
dents. Maintenant, commencez a taper
les paragraphes du document. Vous
remarquerez que, quand vous arrive-
rez en bas du premier cadre, Writer
vous mettra automatiquement dans
le cadre du bas et, quand vous
atteindrez le bas de la premiere
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colonne, Writer vous amenera auto-
matiguement en haut de la deuxieme.

Si votre article fait plus d'une page, :

vous pouvez lier le cadre « Corps
d'Article » a un cadre sur une autre
page. Créer ces liens est une facon

rence est treés professionnelle.

Ajoutons une image a notre cadre

votre document, il faudra la redimen-
sionner. Pour éviter de la déformer,

mettre l'image dans le cadre, tirez-la

jusqu'au coin en bas et a droite du :

cadre, faites un clic droit et choisissez
Ancrer > Au cadre. Double-cliquez sur

l'image pour que le dialogue de ses :
. propriétés s'affiche. Sous
: Adaptation du texte, augmentez l'espa-
. cement & gauche pour créer une zone :
puissante de maitriser la mise en :
pages et la continuité d'un article :
pour créer un document dont ('appa-  en fait des cadres. Quand vous double- e
. . : au moyen d'unités de mesure.
: cliquez sur une image dans un docu- :
- ment, un dialogue de cadre s'affi-:
En-téte : Insertion > Image > A partir :
d'un fichier. Choisissez limage que :
vous voudriez insérer et cliquez sur :
Ouvrir. Si l'image est trop grande pour :

blanche autour de l'image.

chera avec deux nouveaux onglets :

Sous l'onglet Rogner, vous pouvez

Spacing
Left 0.20" -
Right 0.00" -
Top 0.00" -
Bottom 0.00" -

l'onglet :

J

spécial libreoffice

@) volume un

vous n'avez besoin que d'une partie
de l'image ou que vous voulez forcer
l'image a avoir une taille précise sans
déformer le rapport de l'aspect de

- l'image. En outre, vous pouvez mettre

l'image a l'échelle d'une certaine taille

- basée sur un pourcentage de sa taille

Dans LibreOffice, les images sont d.orlglne. Vous pouvez ggalemf ne vi-
. sionner ou changer la taille de l'image

En faisant un clic droit sur l'image,

: VOUS pouvez rajouter une description
Image et Rogner. Sous l'onglet Image, :
vous pouvez refléter l'image vertica- :
lement ou horizontalement. Vous pou- :
. vez préciser si l'image est reflétée sur :
- certaines pages ou sur toutes les pages.
appuyez sur la touche MAJ pendant :
que vous tirez les poignées. Pour :

ou une légende a limage. Le fait
d'ajouter une légende crée un cadre
de texte autour de l'image avec le
texte en dessous de celle-ci. Cette
fonction est utile pour le marquage

- d'illustrations ou de diagrammes dans
ajuster a gauche, a droite, en haut et :
- en bas pour découper certaines par- :
ties de l'image. Ceci est utile quand :

votre document. Une fois la |égende
créée, vous pouvez la mettre en sur-

brillance et la formater comme toute g
: autre partie texte du document.

Vous avez maintenant, je l'espére,

: une idée de la puissance des cadres.
. Notre exemple, il est vrai, était assez :
. simple, mais vous pourriez trés faci-
- lement créer la mise en pages d'un :
- document plus complexe en vous ser- :
. vant des cadres. Puisque vous pouvez
: lier les cadres, vous pouvez créer la
- mise en pages d'un bulletin d'infor- :
' mation ou les articles débutent sur :
. une page, sautent 3 une autre et se
" terminent sur une autre encore. :

13
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La prochaine fois, nous allons exaf
. miner une autre fonction puissante
. de mise en pages disponible dans
Writer de LibreOffice : les sections.

Elmer Perry est éducateur a Asheville,
en Caroline du Nord. Ses passe-temps
comprennent la conception web, la
programmation et l'écriture.
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Ecrit par Elmer Perry

ans la partie précédente:
de cette série, nous avons:
parlé de l'usage de cadres:
dans la mise en pages:
d'un document. Dans cette partie, nous:
allons regarder un autre outil utile de:

mise en pages dans LibreOffice Wri-:
ter : les sections. Les sections se:
distinguent des cadres par plusieurs:
aspects, mais, a certains égards, elles:
peuvent avoir les mémes résultats.:
Alors que les deux vous permettent:
de diviser une partie de votre docu-:
ment en colonnes, quand vous vous:
servez des sections, vous n'en con-:
trélez pas la largeur. Les sections:
occuperont toute la largeur, de la:
marge de gauche jusqu'a la marge de:
droite. En outre, les sections ne peu-:
vent pas se terminer en plein milieu:
d'un paragraphe. Vous ne pouvez pas:
lier des sections comme vous pouvez:
faire pour les cadres. S'il est vrai que:
vous ne pouvez pas lier des sections:
entre elles, elles vous donnent la:
capacité d'établir des liens vers d'au-:
tres documents ou vers une section:
dans un autre document. :

Peut-étre que la meilleure facon:
de concevoir les sections serait de les:
considérer comme un moyen de divi-

( L]
:| New section

ser votre document en différents mor-:
ceaux, comme lintroduction, l'argu-:
ment 1, l'argument 2, etc. Les sec-:
tions peuvent aussi vous permettre:
de séparer une partie d'un document:

L'utilisation des sections |

suite, pour chacune des citations :

Sélectionner la citation entiére.

philosophy

education
ideas
science quote

. J

e

i trez

Nous allons utiliser comme exem-:
ple limportation de citations depuis:
un document de citations. Démarrer:
un nouveau document et y ajouter§
une liste de citations diverses. En

Dans la barre d'outils, allez a In-: e
: du texte Factice a votre document en

© tapant « TEX » et en appuyant sur la

Attribuer un nom parlant 3 la cita-é touche F3). Ecrivez une présentation

: tion (pour exemple, l'une de mes:

afin de l'utiliser dans un autre docu-: iations est de Albert Einstein au’

ment. Les sections peuvent étre un: sujet de la science ; je l'ai nommée!

outil puissant qui vous permet de récu-:
pérer du contenu d'autres documents.

sérer > Section...

citation_science).

Une fois que vous aurez fait de:
: chaque citation une section, enregis-:

le nom de: ; S : )
: contient vos citations, puis Ouvrir.

. Utilisez le menu déroulant des Sec-

Puis, créons un nouveau document: tions pour choisir la citation que vous

et ajoutons un paragraphe ou deux: ' > o
. Sivous voulez protéger votre citation,

le fichier sous
citations.odt.

LibreOFfFfice - Partie 5

de texte (astuce : vous pouvez ajouter

de votre citation et appuyez sur
Entrée. Pour récupérer la citation du
document des citations, Insérer >

: Section... Comme toujours, donnez a
: la section un nom parlant. Cochez

Lier, puis cliquez sur le bouton
parcourir (...) a coté de Nom de
fichier. Choisissez le document qui

voulez insérer dans votre document.

Write protection

.

N\

| Link

| & Link
| DDE
File name File:///home/elmer/Ubuntu ¢ |_|
Section education] v

Protect

with password

spécial libreoffice @) volume un
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cochez Protéger sous Protection
contre les modifications. Vous pouvez

également protéger la section contre:
les modifications avec un mot de:
passe (N.B. : la protection contre la:
modification, méme avec un mot de:
passe, ne veut pas dire qu'un hacker:
mal intentionné ne puisse pas accé-:
der & votre document pour en chan-:
ger le contenu). Vous pouvez rajouter :
les autres citations du document deé

citations de la méme facon.

Editer les sections

Maintenant que les citations sont:
rendons-les visibles du:
premier coup d'ceil avec un alinéa et:
une couleur d'arriére-plan. Format >
Sections. Le dialogue Editer les sec-:

présentes,

tions vous présente une liste des

sections dans votre document. Sélec-:

tionnez celle que vous voulez éditer.
Dans la fenétre principale du dia-

logue, nous pouvons changer le docu-:

Ve

As Color =

Background color

Einstein had this to say about science:

He also had this to say about philosophy:

mouth.

He said this about education:

d

The whole of science is nothing more than a refinement of everyday thinking.

‘When I study philosophical works I feel I am swallowing something which I don't have in my

Education is what remains after one has forgotten what one has learned in school.

~Albert Einstein

~Albert Einstein

~Albert Einstein

)

ment (ou la section de document):
auquel la section est liée. Ici, nous:
pouvons également changer la Pro-:
tection contre modifications et choisir:
de Masquer la section ou non (je ne:
vois aucune raison pratique pour:
laquelle vous masqueriez une partie:
du document, mais vous en avez la:

possibilité en cas de besoin).

p
Indent

Before section

After section

0.30" =

b.30" =

spécial libreoffice

Cliquez sur le bouton Options...:
pour afficher le dialogue des options.:
Sous l'onglet Retraits changez Avant:
la section et Aprés la section pour:
indiquer 1,00 cm. Sous l'onglet Ar-:
riere-plan, choisissez une couleur:
d'arriére-plan pour cette citation. Cli-:
quez sur OK. Editer les autres:

- sections de citation et puis cliquer sur:

OK dans le dialogue Editer les sections.g
Maintenant, vos citations ont un:
alinéa et une couleur d'arriére-plan.

s N

vous demander si ce serait mieux de

~ modifier le document original ou le
: nouveau document. Les deux sont
. possibles. C'est vraiment a vous de

Update
Update links when loading

Always
@® Onrequest

Never

AN y,

: rubrique Actualiser,

. voir. La seule chose dont il faut vous
- souvenir c'est que les modifications

faites a une section liée dans un
document n'apparaitront pas dans le
document original, mais que les modi-
fications du document original peu-
vent éventuellement paraitre dans le
document lié.

Vous pouvez controler les
actualisations dans les options de
LibreOffice Writer : Outils > Options >
LibreOffice Writer > Général. Dans la
VOous pouvez

. choisir d'Actualiser les liens lors du

Modifications faites
dans le document lié

. chargement Toujours, Sur demande
: ou Jamais. Toujours mettra a jour les
. liens quand vous ouvrirez un docu-

: ment contenant des liens. Sur de-

Si vous avez besoin de changer:
l'information dans une section liée a:
un autre document, vous pourriez

volumeun 15

mande vous demandera si vous vou-
lez mettre les liens a jour. Jamais
n'actualisera jamais les liens quand un
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document contenant des liens est
ouvert.

L'actualisation
manuelle de liens

Si vous modifiez le document ori-:
ginal et voulez actualiser le document :
lié pour que ces modifications y:
apparaissent, vous avez deux facons :
de mettre le document lié a jour.:
affichera le dia-:

Editions > Liens...

spécifique et le mettre a jour. Pour:
actualiser tous les liens en une seule:
fois, utilisez Outils > Actualiser > Liens. :

Cadres ou sections ?

de maitrise et vous avez créé un
document Writer contenant toutes
vos citations et données, des sections
seraient sans doute le meilleur choix
pour vous permettre d'insérer des
données dans votre mémoire. Si,
cependant, vous avez besoin de

débuter un article sur une page,
sauter une page, puis le terminer sur

. une autre page, des cadres liés sont:
- un meilleur choix. Prendre du temps:
. pour réfléchir a l'objectif, la mise en
. page et les sources du contenu de

Bien que les cadres et les sections :
. soient souvent similaires, ils ont des:

logue Editer les liens. C'est ici que: fonctionnalités différentes et conviennent :

vous pourrez sélectionner un lien: gonc 3 des objectifs différents. La:
puissante capacité de créer des liens:
vers des parties d'un autre document :
. rend les sections uniques. Souvenez-:
- vous : il faut planifier votre mise en:
. page et décider en amont des outils :

. . . dont vous vous servirez pour accom-:
Parfois, que \'/ous' utilisiez des; plir votre tache. :
cadres ou des sections importe peu. Il :
y a des cas ou l'un ou l'autre peuvent :
faire ce dont vous avez besoin. Cela:
dit, prendre le temps de réfléchir a a':
fonctionnalité de chacun peut vous :
aider 3 faire le meilleur choix. Par:

exemple, si vous écrivez un mémoire :

Dans le prochain article, nous exa-
minerons les styles de page, les en-:
tétes et les pieds de page dans les:

documents Writer.

|k ==

Elmer Perry dont les passe-
temps incluent le web design, la program-
mation et l'écriture, est pasteur pour les
enfants a Asheville en Caroline du Nord.
Son site web est :
eeperry.wordpress.com

spécial libreoffice

Below Lereo

Zéro temps d'arrét

votre document, ainsi qu'aux fonc-:
tionnalités des cadres et des sections, :
vous aidera a décider lequel sera le':
meilleur outil pour votre document.

AR E RN RN RN RN 4
FEEEEE N - L)
SABEEEB SNSRI *| |
L L L L L L L U d r
AsssAsssEBEREBERERBRERERES

e

Below Zero est un spécialiste d'hébergement de serveurs en implan-
tation de proximité au Royaume-Uni.

Contrairement a d'autres, nous ne four-
nissons que l'espace rack et la bande
passante. Cela rend notre service plus
fiable, plus flexible, plus concentré et
plus compétitif quant au prix. Nous
nous spécialisons uniquement dans
I'nébergement de serveurs et de leurs
systemes prés de chez nous, au sein des Centres de données
écossais.

Au ceceur de l'infrastructure de nos réseaux
est le routage BGP4, a la pointe de la
technologie, qui fournit une livraison
optimale des données et aussi un
procédé automatique en cas de panne
faisant appel a nos multiples fournis-
seurs remarquables. Les clients peuvent étre certains que la bande
passante proposée est de qualité maximale ; notre politique est de payer
plus pour les meilleurs fournissseurs et, parce que nous achetons en
gros, nos prix extrémement compétitifs ne sont pas impactés.

Chez Below Zero, nous vous aidons a atteindre Zéro temps d'arrét.

www.zerodowntime.co.uk

@) volumeun 16
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€ mois-ci,

Dans des articles précédents,

que page du méme style.

Pour commencer, nous allons con-§
figurer nos document et styles. Dé-é
marrer un nouveau document texte,§
Fichier > Nouveau. Pour pouvoir accéder :
au titre du document, nous allons chan-:
ger certaines des propriétés du docu-:
ment, Fichier > Propriétés. Sous l'onglet :
. logue de Style de page s'affiche.
General Description Custom Properll: gq ¢ longlet Gérer, nommez le style§
© «Standard ». Changer le Style de suite en':
: Standard. Cela signifie & Writer que,:
: quand nous aurons atteint le bas de la:

( )

Title [This 1s A Tif:
Subject
Keywords
Comments
q y,

nous allons dé-:

couvrir quelques méthodes nou- :

velles pour formater nos docu- :

ments en utilisant les styles de :
page, les en-tétes et les pieds de page.:
jai:
expliqué l'utilisation des styles de para-:
graphe et de caractéres. Les styles de':
page sont similaires, mais traitent de la:
géométrie de l'ensemble et du forma-:
tage de la page entiére. Quant aux en-:
tétes et aux pieds de page, il s'agit des :
zones en haut et en bas de la page. Ils
sont habituellement identiques sur cha-:

Description,

sauvegarder vos changements.

dialogue Styles et formatage, Outils >:

Styles et formatage ou cliquez

sur le bouton Styles et formatage
(3 droite). Cliquez sur le bouton —
styles de page (a droite), Faites
droit dans la fenétre et
sélectionner Nouveau... Le dia- %El

: page, il devra créer une nouvelle page:
: avec le méme style. Sous l'onglet En-téte, :
: cochez Activer l'en-téte, ce qui insérera:
" une zone d'en-téte dans la page. Tou-"

spécial libreoffice @) volume un

mettre comme titre du:
document « Ceci est le titre ». Nous allons :
nous en servir plus tard quand nous:
commencerons & créer nos en-tétes et:
nos pieds de page. Cliquez sur OK pour:
: Sous l'onglet Arriére-plan, choisissez la:
© couleur gris clair pour l'arriére-plan. Cli-:

Maintenant, nous devons configurer :
nos styles de page. Nous allons en uti-:
liser trois : Premiére page, Standard et:
Paysage. Premiére page et Paysage:

jours sous l'onglet En-téte, cliquez sur le
bouton Plus.... Une nouvelle fenétre de':
dialogue s'affichera ; c'est la que nous:
pourrons ajouter une bordure et une:
couleur d'arriére-plan & notre en-téte.:

quez sur OK dans les deux fenétres de':
dialogue et nous avons terminé avec le:
style de notre page Standard.

existent déja, mais nous allons les modi- Header

fier. D'abord, nous créerons notre style:
Standard. Pour ce style Standard, nous:
: voulons une zone d'en-téte en haut, dont :
. l'arriére-plan soit en gris clair. Ouvrez le:

& same content left/right

(Margins |
Left 0.79" "
Right 0.79" -
Top 3.00" .
Bottom 0.79" =

é\ J
: sur le bouton Plus... et choisissez la
: couleur gris clair pour l'arriére-plan.

: Paysage,
. J .

. existe déja. Pour le style Paysage, nous

'onglet Pied de page ou vous cocherez
Activer le pied de page. Cliquez ensuite

Pour régler le style de notre page
nous modifierons celui qui

© ajouterons un En-téte et un Pied de

Pour la Premiére page, nous allons en':

: modifier une qui existe déja. Nous vou-:
un clic:
: pour les graphismes de la premiére page:
rajoutés a un autre moment - et une zone
: de pied de page en gris clair en bas.:

lons une marge du haut de 3" (7,5 cm) -:

Faites un clic droit sur le style Premiére:
page dans le dialogue des Styles et:
formatage et sélectionnez Modifier...:
Sous l'onglet Gérer, choisissez Standard :
comme Style de suite. L'onglet page nous:
permet de changer les marges pour la:
page. Réglez la marge du haut & 3" (7,5:
cm). Cette fois-ci nous allons aussi &°

17

p
.| Background color

page. Faites un clic droit sur le style
Paysage, puis cliquez sur modifier... Pre-
nez le temps de regarder sous l'onglet
Page et remarquez que l'orientation de
la page est bien paysage - exactement ce
que nous voulions. Activez ['En-téte et le
Pied de page sous leur onglet respectif

N\

INo Fill
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et sélectionnez gris clair comme couleur
d'arriere-plan pour les deux.

Nous sommes maintenant préts a:
créer notre document. Double-cliquez sur :
le style Premiére page et le formatage :
de la page de votre document deviendra :
le formatage que nous avons ajouté. :
Vous remarquerez la zone gris clair du :
pied de page en bas. Cliquez a l'intérieur :
de cette zone pour modifier le pied de :
page. Mais d'abord nous allons y ajouter :
le titre, Insertion > Champs > Titre. Le :
titre que nous avons mis dans les:
propriétés du document y sera inséré. :
Vous pouvez utiliser cette méthode pour :
insérer le titre du document partout ou :
vous en avez besoin. Si, par la suite, vous
changez votre titre dans les propriétés :
du document, vous pouvez mettre 4 jour :
toutes les instances du champ inséré :
avec Outils > Actualiser > Champs ou en :
appuyant sur la touche F9 de votre :
clavier. Tapez « Page » en vous assurant :
de mettre une espace de chaque cdté du :
mot Page et insérer le numéro de page, :
Insertion > Champs > Numéro de page. :
Positionnez le curseur au début du mot

L™ L=

This Is A Title]

Page et appuyez sur la touche Tab de

~ votre clavier jusqu'a ce que le numéro de
© page se trouve contre le c6té droit de la:
zone du pied de page. Cliquez en dehors :
de la zone du pied de page pour vous :

retrouver dans le corps de la page.

Une fois que vous aurez fait tout cela,
VouS pourrez commencer a taper votre :
texte. Une fois que vous aurez atteint le :

bas de la page et qu'une nouvelle page: 00 |nsertion > Saut manuel. Sélec-

apparaitra, vous remarquerez qu'elle est : tionnez Saut de page, et sous Style :

formatée en style Standard avec une: c4iectionnez Paysage. Cela vous ménera :
a une nouvelle page avec le style:
Paysage. Comme c'est un style différent : " ) e
de notre style Standard, nous aurons |  assurer la cohérence de certaines infor-
- besoin de remplir les informations d'en-

téte et de pied de page. Ceci est pratique : -
- des numéros de page.

zone d'en-téte en haut. Renseignez l'en-
téte exactement comme nous avons fait :
pour le pied de page de la premiére :
page. Assurez-vous d'utiliser les champs, :
surtout pour le numéro de page. Le:

champ de numero de page Sera 'lftile . si vous voulez un en-téte ou un pied de
quand nous atteindrons la troisieme : page différent sur certaines pages, il
suffit d'insérer une page avec un style de :

: page différent. Lorsque vous avez ter-:

copiées pour vous et que le numéro de : ina yotre page Paysage, créez un autre

page a eté mis a jour afin de O™ : saut de page (Insertion > Saut manuel) :
: avec un style Standard. Vous remar-:

: querez que la numérotation des pages :

Ensuite, nous allons insérer une page : continue, en comptant la ou les pages :

Paysage. Avant d'arriver a une nouvelle :

page. Vous remarquerez alors que les:
len-téte ont été:

informations dans

respondre a la page actuelle.

all that planning and energy wasted? He was dripping with sweat now, cold and we
fear coming off his clothes. Suddenly next to him, with a barely noticeable squeak, a door swung

Writer rend facile I'ajout
de pages avec un style et
une orientation différents,
aussi bien que les en-
tétes et les pieds de
page automatiques.

hw L= L= o

t. he could smell the

Page 1

spécial libreoffice &) volume un
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Paysage insérées. Si vous ne voulez pas

~que les pages Paysage insérées soient
: comptées dans le nombre de pages, vous
: pouvez ajuster manuellement le numéro
. de page dans la boite de dialogue Saut
: manuel.

Writer rend Facile l'ajout de pages

: avec un style et une orientation dif-
. férents, aussi bien que les en-tétes et les
. pieds de page automatiques. Vous pou-

vez faire les en-tétes et les pieds de page

- aussi grands que vous voulez et ils

peuvent contenir toute l'information que
vous voulez y mettre. Les champs aident

mations dans votre document et vous
permettent d'écrire sans vous soucier

Dans le prochain article, je quitterai
Writer pour vous montrer comment faire
la base de données du pauvre en utilisant
un classeur Calc. Apres cela, nous utili-
serons le classeur pour créer une lettre-

type.

(B
Elmer Perry dont les passe-temps incluent
le web design, la programmation et
['écriture, est pasteur pour les enfants a
Asheville en Caroline du Nord. Son site
web est eeperry.wordpress.com
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what do you want to do?

en page de Calc ; ce sera pour une?'
autre fois. Vous devez quand méme:
savoir qu'un classeur est composé d'une
série de colonnes et de lignes. Les:
colonnes sont étiquetées en haut avec:

usqu'a maintenant, nous tra-:
vaillions avec LibreOffice Wri-
ter, mais aujourd'hui nous:
allons nous en éloigner pen-:
dant une seconde pour faire quelque :

Create a new database

Open an existing database file

: . : Recently used
chose d'un peu différent. Nous allons : des lettres (A, B, C,...) et, a gauche, les: o y
créer une base de données primitive : lignes sont étiquetées avec des: Addresses
[Ndt : celle d'un pauvre, un « poor man»] : chiffres (1, 2, 3,...). Quand nous uti-:
dans Calc pour ensuite retourner dans : lisons Calc comme base de données,: Open...

la premiére ligne doit contenir les:
titres des champs pour la base de don-:
nées. Ce sont les en-tétes de champs:
de la base de données. Nous met-:{

Writer pour créer un mailing (ou pu-:
blipostage). Vous acquerrez ainsi des :
notions sur l'utilisation d'un Classeur :
comme base de données. Pour faire:

@® Connectto an existing database

i_5pread§ﬁeet ki _

A

un mailing, il Faut travailler avec une:
base de données quelconque. On pour-:
rait créer la noétre dans Base, mais:
pour un carnet d'adresses simple, [uti-:
lisation de Calc est nettement plus:

facile.

Pour commencer, nous ouvrons Li-
breOffice et cliquons sur Feuille de:
calcul. Ainsi un classeur vierge de Calc:
s'affichera. Je ne vais pas vous don-:
ner beaucoup de détails sur la mise:

trons les en-tétes de champs suivants:
sur la premiére ligne : Titre, Prénom, :
Nom, Adresse (rue et numéro), Ville,:
Code postal et Pays. Chaque champ:
doit étre placé dans une colonne dis-:
- tincte, en commencant par la colonne:
: A ; ainsi, mettez le curseur dans la:
colonne A de la premiére ligne et:
tapez Titre. Pour aller dans la colonne :{
Decide how to proceed after saving the database
che fleche droite du clavier, puis vous::

suivante, vous pouvez utiliser la tou-

pouvez remplir les autres champs.

Sek up a connection to spreadsheets

Click 'Browse..." to select a LibreOffice spreadsheet or Microsoft Excel workbook.
LibreOffice will open this File in read-only mode.
Location and file name

J/home/elmer/Documents/Writing/LibreOffice Series/Poorm ‘ Browse

[ ] Password required

Do you want the wizard to register the database in LibreOffice?

B | c | D | E | @® Yes, register the database for me
Title First Name Last Name Street Address City 5
Jones 123 Some St. Someplace |NC Mo, do not register the database
3 McMahon 321 No Road MNoplace NY :
AlRev. [Mke Mickey 547 Trinity Way |Gospel CT After the database file has been saved, what do you want to do?
5 [Ms.  Amber sSams 34 This Way Thatplace CA (| iopen the database for editing:
6 [Mr. Charlie Hacker 101 Binary Way |Lunix MJ _ :
7 |Ms.  Molly Holly 22 Harvard Rd  |Wally aD Create tables using the table wizard
§ [ ] VAN J/

A\

spécial libreoffice @) volume un
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Sur la deuxieme ligne, nous commen-

cons a taper nos données. Chaque ligne
est un dossier qui contient tous les rensei- :
gnements concernant une personne - du :
moins c'est comme ¢a que je la congois. :
Pour aujourd'hui, inutile de trop vous:
si les données sont plus:
larges que les colonnes. Si vous voulez :
gjuster la largeur des colonnes pendant:
que vous entrez les renseignements, il suf-:

inquiéter

fit de placer la souris au-dessus d'une:
ligne séparant deux colonnes. Le curseur :
deviendra une fleche double et vous pour-:
rez dliquer sur la ligne et la déplacer pour :
augmenter ou diminuer (a largeur de la co-:
lonne. Une fois toutes les données saisies, :
il faut enregistrer le classeur. J'ai sauvegar-:
dé le mien comme Primitive_db.ods.:

Une fois cela fait, fermez-le.

Avant de pouvoir utiliser notre base :
de données primitive, nous avons besoin :
de la référencer dans LibreOffice. Fichier :
> Nouveau > Base de données affichera::
[assistant Bases de données [Ndt : Si vous :
n'avez pas encore le module Base de don-:
nées de LibreOffice, il est disponible dans:
la Logitheque Ubuntu ou par linter-:
médiaire de votre gestionnaire de pa-:
quets habituel]. Choisissez « Connecter :
a une base de données existante » et,:
dans le menu déroulant, sélectionnez:
Classeur. Cliquez sur Suivant. Utilisez le:
bouton Parcourir pour sélectionner:

votre feuille de calculs. Cliquez sur le

bouton Suivant. Assurez-vous que vous

avez sélectionné « Oui, je souhaite que
l'assistant référence la base de données »:
et décochez « Ouvrir la base de données:
pour édition ». Cliquez sur Terminer et:
nommez la base de données (J'ai appelé:
la mienne Adresses). La base de don-i|" & Evolutiontocal
[
classeur. Chaque fois que vous mettrez a:
jour le classeur, la mise & jour paraitra:
. dans la base de données. Le seul hic c'est ;|
que vous ne pouvez pas modifier le:|-
classeur si Writer est ouvert. En fait, une |
base de données de type classeur doit:|-
étre le seul document de LibreOffice ou-:
vert, car, autrement, LibreOffice ouvrira:

nées que vous venez de créer est liée au

le classeur en mode lecture seule.

Maintenant que notre base de don-:
nées est créée et référencée dans LibreOf-:| |
fice, nous pouvons Nous en servir pour:
créer un mailing. Un mailing est vraiment:
intéressant pour expédier des courriers:
types a des clients ou des prospects. Le:
truc génial c'est que vous pouvez:
mettre toutes sortes de données dans:
votre base de données et les utiliser:
dans la lettre. Par exemple, si vous avez:
un programme de récompenses pour:
vos clients, vous pourrez avoir un:
comme cela, :
vous pourriez mettre le nombre de:
points gagnés par chaque:
client dans la lettre, mais:
vous n'auriez besoin de la

champ pour les points ;

3|

taper qu'une seule fois.
spécial libreoffice
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| & & BE ] o @ ™ v valF ¥ | | =
‘v B3 Addresses g Title | g FirstName [ p Last Name |123S;reetngsress |S 5
: B M. m ome St. on
3
- %_?U:l”es I. arry 321 No Road Nof
- ?s Rev. ike 547 Trinity Way Go9
=gst Ms. Amber 54 This Way Tha

101 Blnary Way

———— A~ ter

J

/
ﬂeord Ill Tof
l

Drag field headers

into the documen/

<Street Address>

@) volume un

Start of letter.. |

<Title> <F1/Z\lame} <Last Name>

<City>, <State> <Postal Code>

Dear <Title> <Last Name>,

J

Cliquez sur licone des Sources de don-:
nées, Affichage > Sources de données ou '
appuyez sur F4. Ainsi les bases de don-:
nées référencées s'afficheront en dessous
de la barre du formatage. A gauche,:

vous trouverez Adresses (ou ce que vous: -
- d'un champ de la base de données, vous

avez nommé votre base de données) >

Tables > Feuille1. Coté droit vous verrez:
maintenant vos données mises en page:
comme les entrées dans le classeur.:
Nous insérons les champs dans le docu-:
ment en cliquant sur l'en-téte du champ:
et en le glissant dans le document. Un*

caractére générique pour chaque champ
20

que vous glissez dans le document sera
créé. Assurez-vous de glisser l'en-téte du
champ et non pas des données d'un
dossier.

Vous pouvez maintenant taper votre
lettre. Chaque fois que vous aurez besoin

pouvez le glisser dans le document. Les
champs de la base de données peuvent
étre utilisés a n'importe quel emplace-
ment. Je me répéte : votre base de
données peut contenir toutes sortes de
renseignements dont vous aurez besoin.
Un enseignant pourrait méme ['utiliser
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0 Mail Merge
I 2 zZ A z
| | E | |&|@'|%ﬁ“zs"'|'$' L | | @l
v B3 Addresses Title [ FirstName [ LastName [ StreetAddress [ city [ State [  Postal
» % Queries b [Mr. Tom Jones 123 Some St. Somepli NC 11111 (=] W
v T Tabl Dr. Harry McMahon 321No Road Noplace NY 22222
e Rev.  Mike Mickey 547 TrinityWay  Gospel |CT 77777
] EI [RELEEE Ms. Amber Sams 54 This Way Thatpla|CA 33333 I
» @ Bibliography Mr. charlie Hacker 101BinaryWay  |Lunix |NJ 10101
3 @EVOIUUODLOC&I Recc’i"d I ,i‘(j‘Fl éu - A it mened B Yarall, Py = S =1 = =1 =7 = - =
Records Output
® @ Printer File
Selected records
From: 1 To: 1
== save merged document
save as single document
! Save as individual documents

pour inclure les notes d'un éléve dans:

une lettre pour ses parents.

Une fois la lettre terminée, vous pou- :
vez choisir une sortie imprimante ou une :
sortie fichier. VVous pourriez vouloir choisir :
cette derniére quand vous aurez besoin :
d'y revenir pour ajouter des informations :
personnelles pour certains individus. Par :
exemple, un enseignant voudrait peut-:
étre demander un entretien avec les:
parents d'un éléve qui sera vraisembla-:
blement recalé. Fichier > Imprimer, comme :
pour un document ordinaire. Toutefois, :
LibreOffice vous avertira que le document :
contient des champs de base de données :
d'adresses et vous demandera si vous :
voulez imprimer une lettre type. Répon-:
dez oui et la boite de dialogue du mailing :
s'affichera. C'est ici que vous pouvez choi- :
sir d'imprimer vers une imprimante ou :
vers un fichier. Vous avez également la

pour sélectionner une suite de dossiers. :
Quand vous imprimez vers un fichier, :

vous pouvez choisir d'imprimer vers un:
seul fichier et, dans ce cas, chaque lettre
commencera sur une nouvelle page, ou:
vous pouvez le sauvegarder comme des :
fichiers individuels et, dans ce cas<i:

chaque lettre devrait avoir son propre :

fichier. Vous pouvez choisir de générer un :
nom de fichier & partir de la base de:
données et le champ qui servira de nom. :
Avec ma version de LibreOffice (3.3.3),jai :
eu un seul document quel que soit mon:
choix. Apparemment, ils travaillent encore :
sur cette fonctionnalité. :

Vous pouvez aussi utiliser votre base

spécial libreoffice

de données pour générer des étiquettes.
Fichier > Nouveau > Etiquettes affichera

la boite de dialogue Etiquettes. Choisis-:
sez votre base de données et votre table. :
Clissez les champs dans la boite d'Ins-:
cription. Sélectionnez le type d'étiquette :
et cliquez sur le bouton Nouveau docu-:
ment. Comme c'est le cas pour les lettres:
types, quand vous serez prét a imprimer, :
vous aurez la possibilité de sélectionner :
les dossiers que vous voulez et vous:
pourrez imprimer vers une imprimante :
J ou vers un document. Vous pouvez aussi :
possibilité de n'imprimer la lettre que pour : cr%er des'enveloppes avec a peu pres la
. des dossiers choisis ou pour une plage de: Méme méthode. :
. dossiers. Vous sélectionnez les dossiers :
en cliquant sur la boite grise a son début, :
ou utilisez CTRL-clic pour ne sélectionner :

que quelques dossiers précis ou MAJ-clic:

Il y a une autre facon de créer une:
lettre type, en se servant de Outils >:
Assistant Mailing. L'assistant a pas mal de :
© contraintes et quand jai essayé de:
lutiliser, j'ai trouvé que c'était moins facile :
- d'obtenir de bons résultats. Pour moi, la:

méthode manuelle décrite ici a donné de
meilleurs résultats tout en laissant au
créateur plus de controle sur les sorties.

Le mailing peut vous faire gagner
beaucoup de temps. Tapez votre lettre,
vite fait bien fait, rajoutez des champs de
base de données et imprimez. C'est bien
mieux que de taper des centaines de
lettres ou de modifier chacune d'entre
elles pour changer quelques rensei-
gnements. Dans le prochain article, nous
commencerons a apprendre davantage
sur Calc en créant un classeur simple de
budget.

Elmer Perry dont les passe-temps incluent
le web design, la programmation et
['écriture, est pasteur pour les enfants a
Asheville en Caroline du Nord. Son site web
est eeperry : eeperry.wordpress.com
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